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LESSON 1
Working with Sites

Topics Covered

What are Site Templates?

“Out-of-the-box” Site Templates.

 Creating a new site using Site Templates.

 Creating a Project site.

 Creating a Team site.

 Creating a Community site.

 Creating a Blog site.

 Managing the sites listed in the Top Link Bar.

Introduction

All SharePoint content is accessed through a site. A SharePoint site is the container for
lists and libraries and provides a starting point for basic administration. The content, lists,
libraries, and basic look and feel of a site is initially determined by the Site Template used
to create the site.

❋

1.1. Site Templates

The version of SharePoint determines the initial list of site templates available to create
new sites. The following is a list of child site templates available from a Team Site created
in an Enterprise installation of SharePoint 2019.

Team Site

Blog

Project Site
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Community Site

Document Center

Records Center

Business Intelligence Center

Enterprise Search Center

Basic Search Center

Additional Site Templates can be made available in any installation of SharePoint by
creating custom templates or enabling Farm, Site, and Site Collection features.

❋

1.2. Creating Sites

 1.2.1. Creating a Team Site

In this walk-through you will learn to create new child sites using the Team Site template.

1. Create a new child site named “Marketing” using the Team Site template.

A. Click the Site Contents link in the Quick Launch menu.

B. Click the New drop-down, then Subsite link.
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C. Type “Marketing” in the Title field and “marketing” in the URL name field.
Ensure that the Team Site template is selected in the Select a template:
option.
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D. Scroll down and note the options available for permissions and navigation.
Leave the options at their default settings and click the Create button to
complete the process.
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Looking Forward

In a later walk-through in this lesson, you will learn how to change
the navigation settings of the Marketing site. In a later part of this
course, you will change the permissions.

E. You will automatically be navigated to the Home page of the new
Marketing site. If you have not done much customization to the parent
site it’s hard to tell that this is a different site.
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2. View the lists and libraries that come with the Team Site template.

A. In the Marketing site, click the Site Contents link in the Quick Launch
menu.

B. Take a few moments to look through the Lists and Libraries created by
default from the Team Site template.
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3. Create a new child site to Marketing using the Project Site template.

A. Click the Site Contents link in the Quick Launch menu. Click the New
drop-down, then Subsite link..

B. Select the Project Site template in the New SharePoint Site form and
type “Project X” in the Title field and “projectx” in the URL name field.
Click the Create button to complete the process.
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4. Explore what comes with the Project Site template.

A. Note that the Project Site site home page has a Project Summary view.

B. Click the Site Contents link in the Project X Quick Launch menu.
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C. Notice the addition of the Tasks list that was created by default as
compared to the Team Site template used earlier.

❋
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1.3. Site Navigation

 1.3.1. Managing Site Navigation

This walk-through will explore current navigation settings between parent and child sites.
The walk-through will then modify the child sites to share navigation links with their parent.

1. Verify that both the Project X and the Marketing sites have separate Top Link
Bars and Quick Launches.

A. Verify that you are currently in the Project X home page by clicking the
Project X link in the Top Link Bar.

B. Note that there are no additional links in the Top Link Bar of the Project
X site.

C. There is currently no obvious way to navigate back to the parent site
Marketing from the child site Project X. To navigate back to Marketing,
remove the text in browser’s address field back to “Marketing” as shown
in the screen capture.
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D. Note that now the Top Link Bar has a Marketing link as well as a Project
X link. Also note that the Quick Launch Menu lists only content from this
site.

E. Just as before, there is yet no obvious way to navigate to the parent site
of Marketing. To navigate back to Contoso Home Site, the root site,
remove the text in browser’s address field back to before “Marketing” as
shown in the screen capture.
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F. Note that the root parent site links in the Top Link Bar as shown in the
image. The Contoso Team Site link in this site’s Top Link Bar links to
the Home page for this site. Additionally, the Quick Launch Menu only
has links for content within this site.
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2. Configure the Project X site to share the Top Link Bar of its parent site Marketing.

A. Navigate to the Project X site by first clicking the Marketing link in the
Top Link Bar of the root parent site and then clicking the Project X link
in the Top Link Bar of the Marketing site.

B. Within the Project X site, click the Settings button and select the Site
Settings link from the menu.

C. Click the Top link bar link under the Look and Feel group on the Site
Settings page.

LESSON 1: Working with Sites | 13



D. Click the Use Links from Parent link on the Top Link Bar settings page.

E. Click the OK button on the Message from web page dialog window
warning us that our current Top Link Bar links will be deleted.

F. Verify that now the Project X site has the same Top Link Bar as the
parent Marketing site.

G. Click the Marketing link in the Top Link Bar and verify that it takes us to
the Home page of the Marketing site.
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3. Configure the Marketing site to share the Top Link Bar of its parent site, Contoso
Home Site .

A. Within the Marketing site, click the Settings button and select the Site
Settings link from the menu.

B. Click the Top link bar link under the Look and Feel group on the Site
Settings page.

C. Click the Use Links from Parent link on the Top Link Bar settings page.

D. Click the OK button on the Message from web page dialog window
warning us that our current Top Link Bar links will be deleted.

E. Verify that now the Marketing site has the same Top Link Bar of the
parent, but you have lost the link to Project X.You can fix that by modifying
the Top Link Bar of the root parent site.
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F. Click the Contoso Home Site link in the Top Link Bar and verify that it
takes you to the Home page of the root parent site.

4. Add a new link to the Top Link Bar of the root parent site.

A. While in the root parent site, click the Site Contents button and select the
Site Settings.

B. Click the Top link bar link under the Look and Feel group on the Site
Settings page.

C. Click the New Navigation Link link on the Top Link Bar settings page.
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D. O n  t h e  E d i t  N a v i g a t i o n  L i n k  p a g e  e n t e r
“http://spserver2019/sites/student/marketing/projectx” in the Type the
Web address field. In the Type the description field, enter “Project X”.
Click the OK button to save your changes.

E. Verify that the new Project X link in the Top Link Bar works by clicking
it. The link should take you to the Home page of the Project X site.
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 Exercise 1: Creating Team Sites
 10 to 15 minutes

In this exercise, you will create a new site based on the Team Site template. In addition,
you will test and modify the navigation options from parent site to child site.

1. Create a new child site using the Team Site template.

A. Click the Site Contents link in the Quick Launch menu. Click the New
drop-down, then Subsite link.

B. Type “Accounting” in the Title field and “accounting” in the URL name
field. Ensure that the Team Site template is selected in the Select a
template: option.
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C. Scroll down and note the options available for permissions and navigation.
Leave the options at their default settings and click the Create button to
complete the process.

Looking Forward

In a later walk-through in this lesson, you will learn how to change
the navigation settings of the Accounting site. In a later part of this
course, you will change the permissions.

D. You will automatically be navigated to the Home page of the new
Accounting site. If you have not done much customization to the parent
site it’s hard to tell that this is a different site. Note how this site has its
own Top Navigation bar as well as its own Quick Launch menu.
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Note

Based on the options left at their default values, this child Team Site
does not share any of the links from the parent site.

2. Explore the content of the new child Accounting Team Site.

A. In the Accounting site, click the Site Contents link in the Quick Launch
menu.

B. Take a few moments to look through the Lists and Libraries created by
default from the Team Site template.
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3. Navigate back to the root parent site.

A. There is currently no obvious way to navigate back to the parent site
Contoso Home Site from the child site Accounting. To navigate back to
Accounting remove the text in browser’s address field back to before
“Accounting” as shown in the screen capture.

B. Note that the new Accounting site has a link on the parent site’s Top
Navigation bar.

4. Modify the Accounting site to use the same Top Link Bar as the parent site.

A. Click the Accounting link in the Top Navigation bar.

B. Within the Accounting site, click the Site Contents button and select the
Site Settings link.
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C. Click the Top link bar link under the Look and Feel group on the Site
Settings page.

D. Click the Use Links from Parent link on the Top Link Bar settings page.

E. Click the OK button on the Message from web page dialog window
warning us that our current Top Link Bar links will be deleted.
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F. Note how the Accounting site now has the same Top Link Bar as the
parent site.This makes it easier to navigate back to the parent site as well
as sibling sites.
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 Exercise 2: Creating a Blog Site
 15 to 25 minutes

In this exercise, you will create a new site based on the Blog template.

1. Create a new Blog site as a child site to root parent site.

A. Click the Site Contents link in the Quick Launch menu.

B. Click the New drop-down, then Subsite link..
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C. Select the Blog template and enter “Student Blog” in the Title field and
“studentBlog” in the URL name field.
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D. Scroll down and change the Navigation Inheritance to Yes to use the
top link bar of the parent and then click the Create button to complete the
new blog sites creation process.
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2. Explore the layout and contents of the new Blog site.

A. Take a few moments to read the text within the Home page of the new
blog site.
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B. Click the Settings drop-down and click the Site Contents link from the
menu.

C. Note that the default content for a Blog is one library, Photos, and three
lists, Categories, Comments, and Posts.

D. Click the Home link in the Quick Launch menu to navigate back to the
Home page of the blog site.
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3. Modify the existing Categories and create a new category.

A. Click the ADD CATEGORY link on the Quick Launch menu.

B. Type “IT” in the Title field of the Categories edit form.

C. Click the Save button to save the change.

D. Repeat the previous steps to create categories for “SharePoint” and
“Humor”.

E. Your final list should look similar to the following image.
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4. Create a new blog entry in your blog site

A. Click the Create a post link under the Blogs tools area.

B. In the Posts - New Item form, enter “Import Spreadsheet Error” for the
Title field.

C. Click inside the Body field. Note the Posts - New Item form changes the
toolbar to enable you to enter formatted text as well as insert items such
as images.
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D. Type the following text into the Body field, “Creating a list using the Import
Spreadsheet template can generate the following error if the SharePoint
site is not in Internet Explorer’s Trusted Sites or Intranet zones.”

E. Click the Insert tab in the Editing Tools toolbar.

F. Click the Picture drop-down link on the Insert toolbar and choose From
Computer.

G. In the Select Picture dialog form, click the Browse button to open the
Choose File to Upload dialog window.

H. Navigate to the you downloaded the class files to and select the message-
from-webpage.gif file. Click the Open button to complete the file selection.
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I. Click the OK button to complete the image upload. Note that the file will
be loaded to the Photos library by default.

J. The Photos item editor form will open and provide you with optional
information fields you can include with the image. Enter “Error Message”
in the Title field and click the Save button to save your changes to the
image item.

K. Highlight both IT and SharePoint in the Category list box and click the
Add button. This will associate this post with those categories.
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L. Click the Publish button to complete the creation of the new blog post.

Note

Alternatively, the Save As Draft would have created a post that
would not be visible to the public until it had been published.

M. The Home page with the new blog entry should look similar to the following
image.

Conclusion

In this lesson, you have learned:

What Site Templates are.

About the different types of Site Templates that come “out of the box” with different
versions of SharePoint.

How to create a new site using Site Templates.

How to create a Project site.

How to create a Team site.

How to create a Community site.

How to create a Blog site.

How to manage the sites listed in the Top Link Bar.
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LESSON 2
Page Content

Topics Covered

 Site pages.

Wiki pages.

Web Parts.

 Adding content to the Site Home page.

 Creating a wiki page library.

 Adding Web Parts.

 Managing Web Parts.

Introduction

SharePoint offers a couple of ways to add content to the pages in a site. The latest
technique and the one implemented by the Team Site template is through site style pages.
Another method that has been part of SharePoint in past is the use of Wiki and Web Part
pages. The Wiki and Web Part techniques are similar in the output that can be created,
and both share the ability to add Web Parts (an instance of an app with a view) to them.

❋

2.1. Pages

This walk-through will show you how to edit a page of a team site.  Sites based on the
Team Site template store their default Home page in the Site Pages library that is an
instance of a Site page.The walk-through explore some of the tools available to Site pages
by modifying the site’s Home page.

 2.1.1. Editing Site Page

1. Navigate to the Marketing team site in your browser.
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Click the Edit link at the top of the page.A.

B. Click the Delete link at the top of the News.

C. Confirm the delete process, click Yes.
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D. Click the “+” and choose Document Library.

E. Choose Documents.

F. Choose Save and Close to complete the process.
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 2.1.2. Editing Wiki Pages

1. Navigate to the Marketing team site in your browser.

A. Click the Page link on the quick launch

B. Click New on the top menu then Wiki Page.

C. Name the page and click Create.
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2. Add an image to the Wiki page.

A. Click the INSERT tab to open the toolbar.

B. Click the Picture drop-down link and choose From Computer in the list.
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C. In the Upload Picture dialog form click the Browse button to open the
Choose File to Upload dialog window.

D. Navigate to the course files folder and select the image file. Click the Open
button to complete the file selection.
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E. Click the OK button to complete the image upload. Note that the file will
be loaded to the Documents library by default.

3. Change the layout of the Wiki page.

A. With the page still in edit mode, click the Format Text tab to open the
toolbar. Click the Text Layout drop-down button and select Two columns
from the menu of options.

4. Add text above the image added earlier.

A. Hover and click just to the left of the image so that the insertion point is
located right next to the image.

B. Type the following text to the left of the image: Marketing Rules! Highlight
the text we just typed, “Marketing Rules!” and click the Heading 1 option
from the Styles area of the Format Text toolbar.
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5. Add a link to the Documents library inside the new region below the heading from
the previous steps.

A. With the page still in edit mode hover and click to add your insertion point
just below the “Marketing Rules!” text. On the new line type the following:
[[. A menu will open after you type the second “[”, select List: from the
menu.

B. From the second menu, select Documents/ from the list.
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C. A matching set of “]]” should be automatically added to the end of what
we entered in the previous steps. The completed link should look similar
to the following image.

D. Click the Save and Publish button on the toolbar to save your changes.

E. Verify the wiki style link to Documents works by clicking it. It should take
you to the Documents library.
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❋

2.2. Working with Web Parts

 2.2.1. Adding Web Parts to Pages

This walk-through will show you how to add Web Parts to the Wiki page of the Marketing
site. Due to the large number of Web Parts, this walk-through will only use a few of them
but the basic use and properties are shared by all Web Parts.

1. If the Wiki page is not open, then open it from the  Pages library in the Marketing
site.You may need to click Edit.
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2. Add a Web Part to the page by clicking Insert then Web Part. Click Documents
and Add..

3. Click the Web Part and Edit Web Part to review the options.

4. Click OK to keep changes or Cancel.
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 Exercise 3: Working with Wiki Pages
 15 to 25 minutes

In this exercise, you will add a new wiki page to the root parent site’s Site Pages wiki
library. You will explore the editing tools by editing and adding content to the new wiki
page.

1. Create and edit a new page in the  Pages library of your root parent site.

A. Make sure you are on the Home page of the root site.

B. Click the Site Contents link in the Quick Launch menu.

C. Click the  Site Pages link on the Site Contents page.

Note

The  Site Pages library was created by default when the Team Site
was created. It is also where the sites default Home page is located.

D. Click the New link in the  Site Pages library and choose Wiki Page.

LESSON 2: Page Content | 47



E. In the New Item form, enter “NewCEO” in the New page name field. Click
the Create button to complete the process.

F. Your browser will now be on the new blank page in edit mode. Take a few
moments to familiarize yourself with the FORMAT TEXT and INSERT
toolbars.
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G. Enter the following text into the new page, each on a separate line:

New CEO of Contoso
Please Welcome Wilbur Whipple as the new CEO of Contoso.
Wilbur’s achievements to date include:
Masters degree from NYU
Former CEO of Intel
Retired Marine Sergeant

H. Select and highlight the line “New CEO of Contoso” and click the Heading
3 option from the Styles options in the FORMAT TEXT toolbar.

I. Select and highlight the three lines of Wilbur’s achievements, Master’s
degree from NYU, Former CEO of Intel, and Retired Marine Sergeant.
Click the Bullets button on the FORMAT TEXT toolbar in the Paragraph
group.
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J. Click the Text Layout drop-down button on the FORMAT TEXT toolbar
in the Layout group. Select the One column with sidebar option.

K. Click in the upper-left corner of the new sidebar box to place your insertion
bar at that point.
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L. Click the INSERT tab to open the toolbar.

M. Click the Picture drop-down in the INSERT toolbar and select the From
Computer option.

N. In the Upload Image dialog form, click the Browse button to open the
Choose File to Upload dialog window.
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O. Navigate to the folder you downloaded the class files to and select the
ceo-wilbur.jpg file. Click the Open button to complete the file selection.

P. Click the OK button to complete the image upload. Note that the file will
be uploaded to the Documents library by default.

Q. The final formatted version of the wiki page should look similar to the
following image.

Note

Note that with the picture selected in the wiki page there is a new
IMAGE toolbar tab for formatting the picture on the page.

R. Click the PAGE tab and then click the Save and Publish button to save
your wiki page edits back to the  Pages library.
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2. Edit the Home page of Contoso Team Site.

A. Navigate to the Contoso Team Site in your browser.

i. Click the Edit link at the top of the page.

ii. Click the Delete link at the top of the News.
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iii. Confirm the delete process, click Yes.

iv. Choose Save and Close to complete the process.

Conclusion

In this lesson, you have learned:

What site pages are.

What wiki pages are.

What Web Part are.

How to add content to the Site Home page.

How to create a wiki page.

How to add Web Parts.
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LESSON 3
Site Columns and Content Types

Topics Covered

 Creating Site Columns.

 Creating Content Types.

 Creating a document template for a Content Type.

 Assigning a Content Type to a list or library.

 Creating new items based on a custom Content Type.

Introduction

One method of customizing SharePoint, in a way that can be reused throughout the site
or site collection or even the whole farm, is to create Site Columns and Content Types.
Site columns are the simplest element; they are essentially the same as list and library
columns except that you create them at the site level and then they can be used throughout
that site and any child site. Content Types are a combination of Site Columns as well as
additional settings and information such as document templates and workflows. Content
Types, once created, can then be linked to lists and libraries.

❋

3.1. Site Column Gallery

 3.1.1. Explore the Site Column Gallery

This walk-through will explore the columns available in the Site Column Gallery.

1. Open a browser window if it is not already open and navigate to your root team
site.

2. Click the Settings menu and select the Site Contents option then Site Settings.
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3. Click the Site Columns link in the Web Designer Galleries group on the Site
Settings page.

4. Take a few minutes to browse the list of Site Columns and their groupings. The
image below is a partial list of Site Columns.
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5. Leave the Site Columns gallery open for the next walk-through.

❋

3.2. Creating Site Columns

 3.2.1. Create a Custom Site Column

In this walk-through, you will learn how to create a custom Site Column. Follow the steps
in the previous walk-through to navigate to the Site Column gallery.

1. Click the Create link at the top of the Site Column gallery.
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2. Enter Contoso Department in the Column name field and select Choice (menu
to choose from) from the The type of information in this column is: option
field.

Note

Note that the column type choices are the same as for creating list or library
columns. The main difference with Site Columns is that they can be reused
on multiple lists and libraries throughout the site.

3. Note in the Group region you are leaving the default setting set to Existing Group
and Custom Columns
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4. Scroll down the Site Column page and enter some color values in the list box
field labeled Type each choice on a separate line. Use the following image as
a guide for what to enter.

5. Click the OK button at the bottom of the form to save your work.

6. If you scroll down the list of Site Columns, you will find the new column Contoso
Department under the Custom Columns group.
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 3.2.2. Add a Site Column to a List

In this walk-through, you will learn how to add a Site Column to a SharePoint list. This
walk-through will use the Demo List that was created in an earlier walk-through but any
list or library would work.

1. Click the Demo List link in the site’s Quick Launch menu.

2. Click the Settings then click the List Settings button.

3. Scroll down the List Settings page and to the Columns region. Click the Add
from existing site columns link under the list of columns.
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4. In the Add Columns from Site Columns page, change the Select site columns
from drop-down field to Custom Columns, and click the Add button to move the
Contoso Department column to the Columns to add list.

5. Click the OK button to save our change back to the list’s columns.

6. Navigate back the items view of the Demo List by clicking the link in the Quick
Launch menu or in the breadcrumbs.

7. Click the new item link in the list to create a new item and test the Site Column.
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8. Verify in the Demo List - New Item form that the Contoso Department drop-down
list has the colors that you defined in the Site Column. Click the Cancel button to
close the form without saving.

❋

3.3. Site Content Type Gallery

 3.3.1. Explore the Site Content Types Gallery

This walk-through will explore the content types available in the Site Content Types Gallery.

1. Open a browser window if it is not already open and navigate to your root team
site.

2. Click the Settings menu and select the Site Contents option then Site Settings.

62 | LESSON 3: Site Columns and Content Types

EVALUATION COPY: Not to be used in class.



3. Click the Site content types link in the Web Designer Galleries group on the
Site Settings page.

4. Take a few minutes to browse the list of Site Content Types and their groupings.
The image below is a partial list of Site Content Types.
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5. Leave the Site Content Types gallery open for the next walk-through.

❋

3.4. Creating Content Types

 3.4.1. How to Create and Use Content Types

In this walk-through, you will learn to create a custom content type and apply it to a new
document library.

1. Follow the previous demonstration to navigate to the Site content types gallery.

2. Create a new content type in the Contoso Home Site that extents the Document
content type.

A. From within the Site Content Types gallery page, click the Create link at
the top left of the page.
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B. In the New Site Content form, use the following information to complete
the form.

DataField

Type “Work Order”Name:

Type “Contoso custom content type for work orders”Description:

Select Document Content TypesSelect parent content type from:

Select DocumentParent Content Type:

Type “Demo Content Types”New group:

The completed form should look similar to the following image.

C. Click the OK button to complete the new content type creation process.

3. Add columns to the new Work Order content type.

A. Click the Add from existing site columns link below the Columns region
on the Site Content Type Information page.
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B. In the Add Columns to Content Type form, select Core Task and Issue
Columns in the Select columns from drop-down box. From the Available
columns list box, choose both Due Date and Date Completed then click
the Add button to add them to the Columns to add list box.

C. Click the OK button to complete adding the site columns to the Work
Order content type.

D. Click the Add from new site column link below the Columns region on
the Site Content Type Information page.Es
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E. On the New Site Column form, enter Estimated Price in the Column
Name field. Note the Additional Column Settings available to the
Currency column type but leave everything at their default settings.

F. Click the OK button to save your changes and complete the creation of
the new site column.

4. Assign a document template to the new Work Order content type.

A. Click the Advanced settings link under the Settings region on the Work
Order content type information page.
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B. Click the Upload a new document template option on the Advanced
Settings page and then click the Browse button to find the file.

C. Navigate to the folder you downloaded the class files to and select the
work-order.docx file. Click the Open button to complete the file selection.

D. Click the OK button on the Advanced Settings page to save your changes
to the Work Order content type.

5. Create a new document library named Work Orders.

A. From the root team site, click the Settings icon and select Add an app
from the menu.
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B. Click the Document Library link in the Your Apps template choice page.

C. Click the Advanced Options link on the Adding Document Library
dialog.

D. Type “Work Orders” in the Name field on the New form and leave the rest
of the settings at their default values. Note that the default Document
Template is set to Microsoft Word document.
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E. Click the Create button on the New Document Library form to complete
the new library creation process.

6. Add the Work Order content type to the Work Orders document library.

A. Click the  Settings button then List Settings.

B. Click the Advanced Settings link on the Document Library Settings
page in the General Settings region.
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C. Click the Yes option under the label Allow management of content
types? and then click the OK button at the bottom of the page to save the
change.

D. You should now see a Content Types region that was not being displayed
before you made the change in the previous step.

E. Click the Add from existing site content types link at the bottom of the
Content Types region.
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F. In the Add Content Types form, select Demo Content Type in the
drop-down box labeled Select site content types from. Select Work
Orders in the list box labeled Available Site Content Types and click
the Add button to move it to the list box labeled Content types to add.
Click the OK button to save your changes.

7. Add a new document to the Work Orders library based on the Work Order content
type.

A. Click the Work Orders link in either the Quick Launch menu or the Site’s
Breadcrumbs to take you to the Browse view of the Work Orders library.
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B. Click the New Document text and arrow, careful not to click the icon
above, and note that now there are two choices of document types to
create. Click the Work Order link.

C. Microsoft Word will open a new document based on the template we
loaded into the Work Orders content type.

Note

If you are using Word 2013 you will see a Document Information
Panel that allows you to enter values for the SharePoint fields at the
top of the document. Microsoft removed the Document Information
Panel from the 2016 version of Word. In the next step you’ll use the
File tab in Word to set the SharePoint field values.

D. Click the File tab above the Word toolbar.

E. Click the Show All Properties link on the Info page.
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F. Use the following information in the table to fill in the Document
Information Panel fields.

DataField

Type: “Fix Printer”Title:

Select 5 days from the current dateDue Date:

Leave emptyDate Completed:

Type: “250”Estimated Price:

G. Use the Back arrow in the top left corner of the Info page to navigate back
to the editing view of the document.

H. In the document body, change the title text “Your Company Name” to
“Contoso”. We can optionally fill out any additional information in the
document we like.

I. Click the Save icon in the top-left corner of the Microsoft Word window.
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J. Click the Browse.

K. In the Save As dialog window, enter a name for the document file name
and click the Save button.

L. Close Microsoft Word.

M. If the new document item does not show in our Work Orders library, you
need to refresh your browser view of it. We can do that by clicking the
Work Orders link in the Quick Launch menu.

N. Click the Details Pane button.
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O. Note the properties that are displayed, especially the properties that were
added by the Work Order content type. These properties represent
additional meta data that is stored by SharePoint outside the document
itself.

76 | LESSON 3: Site Columns and Content Types

EVALUATION COPY: Not to be used in class.



 Exercise 4: Creating and Working with
Content Types

 10 to 15 minutes

In this exercise, you will learn to create Content Types and Site Columns. Additionally you
will learn how to associate a document template with a content type based on the
Document parent content type.

1. Create a new Content Type for the Contoso Home Site.

A. Open your browser if it is not already open and navigate to your root team
site.

B. Click the Settings menu and select the Site Contents then Site Settings.

C. Click the Site content types link within the Web Designer Galleries
group.
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D. Take a moment to read through the list of default content types. Note how
they are grouped and there is a parent column that lists the parent content
type of each individual content type.

E. Click the Create link at the top of the list of content types.

F. In the New Site Content form, use the following information to complete
the form.

DataField

Type “Employee Reviews”Name:

Type “Contoso custom content type for employee
reviews”

Description:

Select Document Content TypesSelect parent content type from:

Select DocumentParent Content Type:

Type “Contoso Content Types”New group:

The completed form should look similar to the following image.

G. Click the OK button to complete the new content type creation process.

2. Add columns to the new Employee Reviews content type.

A. Click the Add from existing site columns link below the Columns region
on the Site Content Type Information page.
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B. In the Add Columns to Content Type form, select Core Contact and
Calendar Columns in the Select columns from drop-down box. From
the Available columns list box, choose both Full Name and Job Title
then click the Add button to add them to the Columns to add list box.

C. Click the OK button to complete adding the site columns to the Employee
Reviews content type.

D. Click the Add from new site column link below the Columns region on
the Site Content Type Information page.
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E. On the New Site Column form, enter “Contoso Departments” in the
Column Name field and choose Choice (menu to choose from) in the
The type of information in this column is selection field.

Note

Note that this New Site Column form is the same form you get when
you add a column directly to a list or library.
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F. Locate the Additional Column Settings region further down on the New
Site Column form. Replace the text in the field labeled Type each choice
on a separate line with the following:

Sales
Accounting
IT
Marketing
Training

Click inside the Default value field and make sure “Sales” is set to the
default value. Leave the rest of the settings set to the defaults.

G. Click the OK button to save your changes and complete the creation of
the new site column.

3. Assign a document template to the new Employee Reviews content type.

A. Click the Advanced settings link under the Settings region on the
Employee Reviews content type information page.
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B. Click the Upload a new document template option on the Advanced
Settings page and then click the Browse button to find the file.

C. Navigate to the folder you downloaded the class files to and select the
Employee Review.docx file. Click the Open button to complete the file
selection.

D. Click the OK button on the Advanced Settings page to save your changes
to the Employee Reviews content type.
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 Exercise 5: Adding a Content Type to a
Library

 10 to 15 minutes

In this exercise, you will learn to associate the custom content type you built in the previous
exercise with a new Document Library.

1. Create a new Document Library.

A. From the root team site, click the Settings icon and select Add an app
from the menu.

B. Click the Document Library link in the Your Apps template choice page.
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C. Click the Advanced Options link on the Adding Document Library
dialog.

D. Type “Reviews” in the Name field on the New Document Library form
and leave the rest of the settings at their default values. Note that the
default Document Template is set to Microsoft Word document.

E. Click the Create button on the New Document Library form to complete
the new library creation process.

F. Click the Settings then Library Settings.
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2. Add the Employee Reviews content type to the Reviews document library.

A. Click the Advanced Settings link on the Document Library Settings
page in the General Settings region.

B. Click the Yes option under the label Allow management of content
types? and then click the OK button at the bottom of the page to save
your change.
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C. You should now see a Content Types region that was not being displayed
before you made the change in the previous step.

D. Click the Add from existing site content types link at the bottom of the
Content Types region.

E. In the Add Content Types form select Contoso Content Type in the
drop-down box labeled Select site content types from. Select Employee
Reviews in the list box labeled Available Site Content Types and click
the Add button to move it to the list box labeled Content types to add.
Click the OK button to save your changes.
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3. Add a new document to the Reviews library based on the Employee Reviews
content type.

A. Click the Reviews link in either the Quick Launch menu or the Site’s
Breadcrumbs to take you to the Browse view of the Reviews library.

B. Click the Documents tab in the Library Tools toolbar in the new Reviews
document library.

C. Click the New Document text and arrow, careful not to click the icon
above, and note that now there are two choices of document types to
create. Click the Employee Reviews link.

D. Microsoft Word will open a new document based on the template you
loaded into the Employee Reviews content type.
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Note

If you are using Word 2013 you will see a Document Information
Panel that allows you to enter values for the SharePoint fields at the
top of the document. Microsoft removed the Document Information
Panel from the 2016 version of Word. In the next step you’ll use the
File tab in Word to set the SharePoint field values.

E. Click the File tab above the Word toolbar.

F. Click the Show All Properties link on the Info page.
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G. Use the following information in the table to fill in the Document
Information Panel fields.

DataField

Type “Homer’s Review”Title:

Type “Homer Simpson”Full Name:

Type “Senior Technician”Job Title:

Select ITContoso Departments:

H. Use the Back arrow in the top left corner of the Info page to navigate back
to the editing view of the document.

I. In the document body, change the title text “Company Name” to “Contoso”.
Feel free to fill out any additional information in the document you like.

J. Click the Save icon in the top left corner of the Microsoft Word window.

K. Click the Browse link.

L. In the Save As dialog window, enter Homers Review.docx for the document
file name and click the Save button.
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M. Close Microsoft Word.

N. Click the ellipsis next to Homer’s Review item then click the second ellipsis
in the balloon pop-up. From the drop-down menu, select the Properties
link.

O. Note the properties that are displayed especially the properties that were
added by the Employee Reviews content type.These properties represent
additional meta data that is stored by SharePoint outside the document
itself.
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Conclusion

In this lesson, you have learned:

About Site Columns.

About Content Types.

How to create Site Columns.

How to create Content Types.

How to create a document template for a Content Type.

How to assign a Content Type to a list or library.

How to create new items based on a custom Content Type.
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LESSON 4
Managing SharePoint Site Permissions

Topics Covered

 About SharePoint groups.

 How to create SharePoint groups.

 How to assign permission in SharePoint.

 How to view permission levels.

 How to manage permission inheritance at the site level.

 How to manage permission inheritance at the list or library level.

 How to manage permission inheritance at the item level.

Introduction

Permissions on a SharePoint site are assigned when a site is created. The default is that
permissions assigned to the root of a site collection are inherited by child sites. At any
time, permissions inheritance can be turned off at a site, list, library, or even at the item
level in a list or library. The permissions themselves can be assigned to either SharePoint
groups, individual users or groups created outside of SharePoint such as Windows groups.

❋

4.1. SharePoint Groups

 4.1.1. View the Default SharePoint Groups

SharePoint creates default groups based on the template used to create the root site in
the site collection. In the following demonstration, we will view the default groups created
in our Contoso Home Site that was created with the Team Site template. Later in this
lesson, we will explore how child sites inherit these groups by default and how to change
that.

LESSON 4: Managing SharePoint Site Permissions | 93



1. Make sure our browser is open on the Contoso Home Site. If it is not already
open, then navigate to our Contoso Home Site by typing
“http://spserver2010/sites/student??”, replacing the “??” with your assigned student
number, in the browser URL field.

2. Click the Site Actions menu link and then select the Site Permissions link from
the available options.

3. Verify the default groups in the list are Members, Owners, Visitors, and Viewers.
Note that the Members, Owners, and Visitors groups have the site’s name
Contoso Home Site appended to them.
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4. Click the Contoso Home Site Members link to view the list of members and verify
that it is currently empty.

Note that when we view a SharePoint group’s membership list, the Quick
Launch menu is modified to provide links to the other SharePoint groups for
easy access.

5. Click the Viewers link in the Quick Launch menu to view its members and verify
that it is currently empty.

6. Click the Contoso Home Site Visitors link in the Quick Launch menu to view
its members and verify that it is currently empty.

7. Click the Contoso Home Site Owners link in the Quick Launch menu to view
its members and verify it contains our Student?? account as well as the SP_Admin
account.
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These accounts were added during the creation of the root site and site
collection.

8. Click the Site Actions menu link and then select the Site Permissions link to
navigate back to the original view of all the groups and the Permission Tools
toolbar.
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Note that we could alternatively click the Groups link or the More… link in
the Quick Launch to view the People and Groups: All Groups list. One
downside to this view is it does not provide us the Permission Tools toolbar.

9. Create a new SharePoint group.

A. Click the Create Group link button from the Edit tab of the Permission
Tools toolbar.

B. Enter Designers in the Name field of the Create Group form.
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C. Leave the owner user set to our Student?? account.

Note that we can only have one entry for the Owner, but we can
switch the user for a group.

D. Leave the default options set in the Group Settings region.

E. Leave the default options set in the Membership Requests region.
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F. Select the Design option in the Give Group Permission to this Site
region and click the Create button to complete the process.

The Design permission has more site level permissions than the
Contribute level but less than the Full Control level. Later in this
lesson, we will cover Permission Levels.

❋

4.2. Assigning Permissions

Assigning permissions to SharePoint resources can be done several different ways. One
method is to assign a user or group account, typically Windows users or groups, directly
to resource as the following image shows the dialog to do that.
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The recommended method is to grant permissions by adding user or group account into
the SharePoint groups.The following demonstration will take this recommended approach.

 4.2.1. Add a User Account to a SharePoint Group

In this demonstration, we will use the recommended method of adding a Windows user
account into a SharePoint group to receive the permissions level assigned to that group.

1. Make sure our browser is open on the Contoso Home Site. If it is not already
open, then navigate to our Contoso Home Site by typing
“http://spserver2010/sites/student??”, replace the “??” with your assigned student
number, in the browser URL field.

2. Click the Site Actions menu link and then select the Site Permissions link from
the available options.
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3. Click the Grant Permission link button from the Edit tab of the Permission Tools
toolbar.

4. Enter DemoUser in the Users/Groups field and click the Check Names icon just
below the field to resolve the name.The name will be underlined once it is resolved
successfully.
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The Check Names button is not required but it saves us an error message
if we have not typed the name correctly.

5. Change the Add users to a SharePoint group (recommended) drop-down option
to Contoso Home Site Visitors [Read].

6. Uncheck the Send welcome email to the new users option and click the OK
button to complete the process.

❋
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4.3. Permission Levels

Permission level can only be created by Site Collection administrators or Farm level
administrators. For that reason, creating and modifying permission levels is outside the
scope of this course. What we will do is view the granular permissions that are combined
in a permission level. The permission levels usage you have already seen in the earlier
demonstration when we created a new SharePoint group.You can also assign a permission
level directly to a user or group, Windows users and groups typically, but this is not
recommended.

 4.3.1. View Permission Level Permissions

In this demonstration, we will view the granular permissions that are assigned to the Full
Control permission level.

1. Make sure our browser is open on the Contoso Home Site. If it is not already
open, then navigate to our Contoso Home Site by typing
“http://spserver2010/sites/student??”, replacing the “??” with your assigned student
number, in the browser URL field.

2. Click the Site Actions menu link and then select the Site Permissions link from
the available options.
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3. Click the Permission Levels link button from the Edit tab of the Permission
Tools toolbar.

Note that the Permission Levels link button is only available at the root site
of the Site Collection.

4. Click the Full Control link in the Permission Levels page to view the permissions.
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5. Note the permissions are divided into three groups List Permissions, Site
Permissions, and Personal Permissions. Take a few moments to read through
the list of permissions and their descriptions.
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6. Click the Cancel button at the bottom of the Permission Levels page once we
are done viewing the permissions.

❋

4.4. Permissions Inheritance

Permissions are initially assigned to the root site of the Site Collection when it is created.
Child sites have the option when they are created to use unique permissions or inherit the
permissions of the parent site. The default setting is to inherit permissions but you can
always break the inheritance and assign unique permissions any time you like provided
you have the permission to do so.

Permissions to lists libraries and the items within are similar in that they automatically
inherit the permissions of their parent site. Just as with child sites, you can always turn off
the inheritance and manage permissions in the list, library, or even the individual item.

 4.4.1. Modifying Permissions Inheritance

In this demonstration, we will turn off permissions inheritance first in the Golf Clubs list
and then in the child site Sub Site A.

1. Make sure our browser is open on the Contoso Home Site. If it is not already
open, then navigate to our Contoso Home Site by typing
“http://spserver2010/sites/student??”, replacing the “??” with your assigned student
number, in the browser URL field.

2. Modify the permissions of the Golf Clubs list.

A. Click the Golf Clubs link in the Quick Launch menu.

B. Click the List tab of the List Tools toolbar for the Golf Clubs list.
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C. Click the List Permissions icon on the far right of the List tab toolbar.

If the browser window is not wide enough, the List Permissions
icon may not display, but it will be listed under the Settings button
menu. Alternatively, we could use the List Settings page and the
Permissions for this list link on there.

D. Note on the List Permissions page for the Golf Clubs list there is a
banner notifying us that the list is inheriting permissions from its parent
Contoso Home Site.

E. Click the Stop Inheriting Permissions link button to turn off the inheritance
for the Golf Clubs list.
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F. Click the OK button on the Message from web page dialog window
notifying us that permission from the parent will no longer affect this list.

G. Note that now the List Permissions page banner is notifying us that This
list has unique permissions and the Permission Tools toolbar has
more options including a link button to Grant Permissions.

3. Modify the permission of the Sub Site A child site.

A. Click the Navigate Up icon and select Contoso Home Site to navigate
back to the Home page of our root parent site.
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B. Click the Sub Site A link from the Top Link Bar to navigate to the child
Team Site.

C. Click the Site Actions menu link and then select the Site Permissions
link from the available options.
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D. Note on the Site Permissions page for the Sub Site A site there is a
banner notifying us that the list is inheriting permissions from its parent
Contoso Home Site.

E. Click the Stop Inheriting Permissions link button to turn off the inheritance
for the Sub Site A child site.

F. Click the OK button on the Message from web page dialog window
notifying us that permission from the parent site will no longer affect this
site.

G. Note that now the Site Permissions page banner is notifying us that This
website has unique permissions.
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 Exercise 6: Working with SharePoint
Permissions
 15 to 25 minutes

In this exercise, you will learn to manage permissions on your SharePoint site.

1. Log in to the Contoso Home Site as “Homer” and verify that Homer does not
have any permissions to the site.

A. Open your browser if it is not already open and navigate to your Contoso
Home Site by typing “http://spserver2010/sites/student??”, replacing the
“??” with your assigned student number, in the browser URL field.

B. Click the Open Menu link button in the upper-right corner of the browser
window that displays your user name “Student??” and click the Sign in
as Different User from the drop-down.

C. In the Widows Security dialog window, enter “Homer” for the User name
field and “Pa$$w0rd” for the Password field. Click the OK button to
complete the logon.
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D. Verify that Homer gets an Error: Access Denied page.

E. Click the Sign in as a different user link in the middle of the Error:
Access Denied page.
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F. Click the Use another account button in the Windows Security dialog
window.

G. In the Widows Security dialog window, enter “Student??”, replacing the
“??” with your assigned student number, for the User name field and
“Pa$$w0rd” for the Password field. Click the OK button to complete the
logon.

2. Grant a new user Visitor permissions to the Contoso Home Site.
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Click the Site Actions menu link and then select Site Permissions from
the drop-down menu.

A.

B. On the Site Permissions page, take a moment to read the existing entries
and their Permission Levels.
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C. Click the Student?? Team Site Owners, replacing the “??” with your
assigned student number, SharePoint group from the list to view its
members.

D. In the Student?? Team Site Owners list page note that the “Student??”
account you are logged in with is a member.This gives you full permissions
to the site.

E. Click the Site Actions menu link and then select Site Permissions from
the drop-down menu, or use your browser’s Back button to go back to the
Site Permissions page.

F. Click the Check Permissions link button in the Permission Tools Edit
tab toolbar.
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G. In the Contoso Home Site: Check Permissions dialog form enter
“contoso\Homer” in the User/Group field and click the Check Now button.

H. Verify that the results of the permissions check are None. Click the Close
button to close the dialog form.

I. Click the Grant Permissions link button in the Permission Tools Edit
tab toolbar.
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J. In the Grant Permissions dialog form type “contoso\Homer” in the
Users/Groups field and then click the Check Names icon to resolve it.
The name should resolve to “Homer Simpson” after you click the Check
Names icon.

K. In the Grant Permissions area, leave the selections set to Add users to
a SharePoint group (recommended) but change the list box to
Student?? Team Site Visitors [Read], replace the “??” with your student
number. Click the OK button to complete the permissions assignment.
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L. To verify that Homer has the correct permissions now, click the Check
Permissions link button in the Permission Tools Edit tab toolbar.

M. In the Contoso Home Site: Check Permissions dialog form, enter
“contoso\Homer” in the User/Group field and click the Check Now button.

N. Verify that the results of the permissions check now is Read. The results
should be similar to the following image. Click the Close button to close
the dialog form.
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3. Login to the Contoso Home Site as “Homer” and verify that Homer does have
Read permissions to the site.

A. Click the Open Menu link button in the upper-right corner of the browser
window that displays your user name “Student??” and click the Sign in
as Different User from the drop-down.

B. In the Widows Security dialog window enter “Homer” for the User name
field and “Pa$$w0rd” for the Password field. Click the OK button to
complete the logon.
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C. Verify that Homer can now see the Home page of the Contoso Home
Site.

D. Click the Site Actions drop-down button and note that the items listed
are security trimmed based on Homer’s rights.

E. Click the Favorite Cars list in the Quick Launch menu and verify that
Homer can see the items in the list.
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F. Click the Bugatti link within the Favorite Cars list to view its properties.

G. Note that the Edit Item button on the View toolbar in the Favorite Cars
- Bugatti dialog form is grayed out and Homer is unable to click it.

H. Click the Close button to close the Favorite Cars - Bugatti dialog form.

4. Grant Homer contribute permissions to the Favorite Cars list.
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Click the Open Menu link button in the upper-right corner of the browser
window that displays “Homer” and click the Sign in as Different User
from the drop-down.

A.

B. Click the Use another account button in the Windows Security dialog
window.

C. In the Widows Security dialog window enter “Student??”, replacing the
“??” with your assigned student number, for the User name field and
“Pa$$w0rd” for the Password field. Click the OK button to complete the
logon.
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D. Click the Favorite Cars link in the Quick Launch menu.

E. Click the List tab in the List Tools toolbar.

F. Click the List Permissions icon within the Settings region on the List
tab toolbar.
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The List Permissions icon text may or may not be displayed
depending on the size of your browser window.

G. Click the Stop Inheriting Permissions link button in the Edit tab of the
Permission Tools toolbar.

H. Click OK to the Message from web page dialog window to accept the
change.

I. Note that the Permission Tools toolbar has changed now that it is no
longer inheriting permissions from the parent site. Click the Grant
Permissions link button in the Edit tab of the Permission Tools toolbar.
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J. In the Grant Permissions dialog form type “contoso\Homer” in the
Users/Groups field and select Contribute under the Grant users
permissions directly option list.

K. Click the OK button at the bottom of the Grant Permissions dialog form
to save your changes.

L. Note that Homer Simpson (Contoso\homer) is now in the permissions
list for Favorite Cars with Contribute permission.
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5. Grant Homer Full Control permissions to the Accounting child site.

A. Click the Navigate Up icon and select Contoso Team Site link from then
menu.

B. Click the Accounting link in the Top Link Bar of the Contoso Home
Site.

C. In the Accounting site click the Site Actions menu link and then select
Site Permissions from the drop-down menu.
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D. Note that the permissions of the Accounting site are inheriting the
permissions of its parent site Contoso Home Site.

E. Click the Stop Inheriting Permissions button on the Permission Tools
Edit tab toolbar.
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F. Click the OK button on the Message from web page dialog window to
accept the unique permissions setting.

G. Note that the Permission Tools toolbar has changed now that the site
has unique permissions. Click the Grant Permissions button on the Edit
tab of the Permission Tools toolbar.

H. Type “contoso\Homer” into the User/Groups field and change the Grant
Permissions option to Grant users permissions directly and add a
check to the Full Control - Has full control check box.
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I. Click the OK button at the bottom of the Grant Permissions dialog form
to save your changes.

J. Click the Contoso Home Site in the Navigate Up menu to navigate back
to the parent site.

6. Test the new permissions given to Homer in the Favorite Cars list and the
Accounting child site.

A. Click the Open Menu link button in the upper-right corner of the browser
window that displays your user name “Student??” and click the Sign in
as Different User from the drop-down.
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B. Click the Use another account button in the Windows Security dialog
window.

C. In the Widows Security dialog window enter “Homer” for the User name
field and “Pa$$w0rd” for the Password field. Click the OK button to
complete the logon.
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D. Click the Site Actions drop-down button and note that the options are still
limited to Homer in the Contoso Home Site.

E. Click the Favorite Cars list in the Quick Launch menu and verify that
Homer can see the items in the list.
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F. Click the Bugatti link within the Favorite Cars list to view its properties.

G. Note that the Edit Item button and Delete Item button on the View toolbar
in the Favorite Cars - Bugatti dialog form are available to Homer to use.

Feel free to test Homer’s editing abilities by changing any of the values
you like.

H. Click the Accounting link in the Top Link Bar of the Contoso Home
Site.
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I. Click the Site Actions menu in the Accounting site and note that Homer
has full access to all the items in the menu due to his Full Control
permissions at this child site.

J. Optional: Take a few moments and test any action in the Accounting site
logged in as Homer to verify his permissions.

Conclusion

In this lesson, you have learned
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About SharePoint groups.

How to create SharePoint groups.

How to assign permission in SharePoint.

How to view permission levels.

How to manage permission inheritance at the site level.

How to manage permission inheritance at the list or library level.

How to manage permission inheritance at the item level.
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LESSON 5
Participating in User Communities

Topics Covered

 Editing a personal profile.

Introduction

SharePoint offers users a place for social collaboration in the form of personal sites. The
experience and functionality is very similar to popular social media sites such as Facebook
and LinkedIn. The main difference being that it is controlled by the SharePoint Farm and
exposure is typically limited to internal networks.

❋

5.1. Configure User Profiles and My Sites

Information about people within a SharePoint organization comes primarily through
SharePoint User Profiles. User Profiles are managed by the User Profile Service that
comes with SharePoint Server, the pay version, but must be provisioned by the Farm
administrator. As part of the provisioning process the Farm administrator creates a special
Site Collection for hosting My Sites. In addition to creating the My Sites host the Farm
administrator typically configures a synchronization connection with a directory system
such as Active Directory. It is from this synchronization connection that User Profiles are
populated with information such as email addresses and company information. Users have
the ability to add and edit some information to their profiles as well as decide who can
view the information. Profile fields that are imported from Active Directory default to
read-only and that includes the Show To option. The Farm administrator can change the
default edit ability of these fields as well as add new custom fields.

The following walk-through will show you how to edit the profile for the account. This
walk-through uses an account named “SP_Admin” but any account will do.

Note

Note that due to the way the labs are set up, you cannot actually do this within the
lab
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1. Edit the profile for your user account.

A. Click the Open Menu drop-down menu and select the About Me option.

B. Click the edit link on the About page.

C. Review the options..
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❋

5.2. Newsfeeds

Newsfeeds in SharePoint 2019 provide a way to track people, documents, sites, and
interests (tags). Newsfeeds are accessed and managed through your user profile.

❋

5.3. Managing and Viewing Personal Information and Content

In this reading, you will learn to configure your SharePoint profile.

1. Edit the profile for your user account.
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Click the Open Menu drop-down menu and select the About Me option.A.

B. Click the edit link on the About page.

C. Review the options..
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Conclusion

In this lesson, you have learned:

How to edit a personal profile.
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